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1 Introduction

Gateway is Vizrt’s implementation of the Media Object Server (MOS) Protocol. It enables users of a Newsroom
Computer System (NRCS) to perform instant updates on running orders (rundown/playlist) in Vizrt content control
applications such as Viz Trio and Viz Pilot.

As Gateway supports multiple NRCS connections, it allows content control applications to request and monitor
multiple running orders from multiple newsroom systems. By supporting the MOS protocol, Vizrt is able to integrate
a wide range of its products with Newsroom Computer Systems that support the MOS Protocol.

The Gateway Controller Client’s graphical interface is browser-based.

Q Important! A 64-bit version of Windows is required to run Gateway.

1.1 Related Documents

Gateway has previously been known as Vizrt Viz Gateway, Viz Gateway or Viz MOS Gateway. As of version 2.0, the
preferred name is simply Gateway.

All related documents contain information on how to configure a content control application to request running
orders from the newsroom system through the Gateway connection. For complementing information see the
following documents:

1. Viz Pilot User Guide: Contains information on how to create content based on templates, how to playout
elements in playlists based on these templates, and how to install and configure Viz Pilot as a stand-alone
product, and with integrated third-party systems such as newsroom systems and other Vizrt products.

2. Viz Trio User Guide: Contains information on how to use the Vizrt character generator for real-time update of
scenes from the operator desk.

° Tip: You can find updated documentation for Viz software on the Documentation portal.

1.2 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback and/or
suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

Copyright © 2024 Vizrt Page 6
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2 Overview

Gateway is a framework for integrating newsroom tasks into the Vizrt ecosystem. Gateway supports Newsroom
Computer Systems (NRCSs) based on the Media Object Server (MOS) Protocol, as employed by leading NRCS
vendors.

This section describes the supported Gateway features and basic workflow from design to playout.

2.1

Features

Gateway’s main features are:

Enables connections to multiple NRCSs.

Enables monitored running orders to be automatically updated by the newsroom system.

All media objects fetched from Vizrt systems are editable in Vizrt’s content control applications to allow last
minute edits.

Last minute edits can also be done in Vizrt’'s Newsroom Component.

Enables content control applications to monitor multiple running orders.

Enables Vizrt’s content control applications to take ownership of a running order from another studio in case
of a fail situation.

Easy-to-use interface for configuring and monitoring all connections to NRCSs and content control
applications.

Failover support to enable transparent operation, should the main NRCS server fail or need to be
maintained.

Control Station Backup automatically updates backup clients, ensuring that both the backup client and
main system have the same MOS playlists.

Sobey Failover System allows the Gateway server to send its messages to more than one NRCS system.
Secure MOS communication (MOS v. 4.0) including websockets secure and user authentication.

2.2

Workflow

The basic workflow is as follows:

Ajournalist adds a story to the newsroom system using a newsroom client.

In the NRCS client, a Newsroom Component from Vizrt can be used to fill templates with different media
objects containing character-generated text, maps, stills or videos.

Templates are based on 2D/3D graphics scenes, pre-made to fit a specific concept or style, for example the
Nine O’clock News.

The Newsroom Connect Component allows the user to select a template related to a concept, fill it, and
store it as a new media object with a describing name.

All external media objects, as those created by the Newsroom Connect Component, can be added to a story.
When media objects are added to a story, the NRCS creates unique placeholders for each media object,
called items.

When the story is saved, it is populated to a story pool. From the story pool, the story is typically added to a
running order (also known as a rundown or playlist).

Copyright © 2024 Vizrt Page 7
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A running order can contain more than one story, and one story can contain more than one item. Each item
keeps track of one media object that is stored on external servers.

A running order can be requested from a content control application or conversely.

As stories with new items (data elements) are added to the running orders, the Gateway is notified.
Gateway passes on running order messages to the content control applications holding the running order
for playout, and updates the newsroom system of changes to a data element by the journalist.

Gateway Workflow: Connecting Newsroom Systems to Content Control systems.
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3 Requirements

This section describes the prerequisites such as software and hardware requirements in order to install and run the
Gateway server and Gateway Controller Client. It is also recommended to check the Release Notes distributed with
the Media Sequencer installer for any late-minute updates.

This page contains the following information:

« Minimum Software Requirements
« Media Sequencer
« Operating System
« Oracle Client
« Viz Pilot Schema Version
« Minimum Hardware Requirements
 Oracle Hardware Requirements (19c)

3.1 Minimum Software Requirements

The following software is required to complete a Gateway installation:

3.1.1 Media Sequencer

« Microsoft .NET framework 4.7.2 must be installed on the host machine. This is usually already installed on a
Windows operating system. The installer notifies the user if NET framework is not found.

+ The WIBU CodeMeter runtime must be installed and configured to run the Media Sequencer and Gateway.
The CodeMeter runtime is installed as part of the Media Sequencer bundle installer. CodeMeter is mandatory
as of version 5.4.

+ A 64-bit version of MS Windows (Media Sequencer is a 64-bit application).

« Gateway. This component is included in the Media Sequencer installer. Refer to the Installation section of
this guide for detailed instructions.

Note that the Gateway component must be selected when installing Media Sequencer.

+ Astandard web-browser, for example Google Chrome, Microsoft Edge, or Firefox, to access Gateway

Controller, a web application for configuring the Gateway.

3.1.2 Operating System

« Server: Windows Server 2016 or higher.
» Workstation: Windows 10 or higher.

€ Important! Operating systems that have reached their end-of-life cycle and are no longer officially
supported by their manufacturers are not supported for use with Gateway.

Copyright © 2024 Vizrt Page 9
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3.1.3 Oracle Client

« An Oracle Client is only required when using the Oracle database backend.
+ A 64-bit version of the Oracle Client is required.
« Either the Full Oracle Client or Oracle Basic Instant client can be used. Oracle XE client is not supported.
« The recommended version of the Oracle Client is the same version/release as the Oracle Database itself.
Version mismatch between Oracle Database and Client can lead to subtle errors and is not supported.
« The recommended Oracle Database version is 19¢, which is also the newest version supported due to
breaking change in newer versions.

Note: If you are using Viz Pilot Data Server you do not need the Oracle client on the Gateway host.

Q Important! Gateway uses the Media Sequencer in an exclusive configuration to operate as a gateway.
Hence the server that runs the Gateway cannot operate as a “normal” (non-exclusive) Media Sequencer
while functioning as a Gateway.

3.1.4 VizPilot Schema Version

If running Gateway version 5.3 or later using Oracle database as back end, the Viz Pilot Database schema must be
version 5.2 or newer (which fixes the GET_ALL_ELEMENTS procedure bug).

3.2 Minimum Hardware Requirements
The following, separate hardware components are required for the two nodes Gateway and Oracle Database Client.

« Gateway
« There are no specific hardware requirements for Gateway. The hardware required and network
interface depend on the number of Newsroom Systems and clients using the gateway.
However, it is strongly recommended that Gateway is installed on its own computer or server.
Sharing space with other resource-intensive systems, for example a database, is not recommended.
+ Oracle Database Client
« Currently (for Oracle 19¢) the requirements are listed as:

3.2.1 Oracle Hardware Requirements (19c)

Requirement Minimum Value
Physical memory (RAM) 2 GB minimum

Virtual memory « If physical memory is between 2 GB and 16 GB: 1x the size of the RAM.
« If physical memory is more than 16 GB: 16 GB.

Copyright © 2024 Vizrt Page 10
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Requirement Minimum Value

Disk space Total: 10 GB
Processor AMDG64 or Intel EM64T
Video adapter 256 colors

Screen Resolution 1024 X 768 minimum

0 Important! The values above are a minimum requirement. Please refer to the official Oracle
Documentation at https://docs.oracle.com/en for current information.

Note: The Oracle database client is not necessary if you are connecting to Oracle via Viz Pilot Data Server.

Copyright © 2024 Vizrt Page 11
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4

Installation

This section describes how to install the Gateway system. The installation consists of the following steps:

1.

w

Install the Gateway software. The Gateway is bundled as an optional component in the Media Sequencer
installer.

If there is an existing Oracle Database installed, configure the new Gateway installation to use the existing
Oracle Database. Otherwise, a new Oracle Database must be installed and configured.

Install the Oracle Client on the Gateway server.

Use the browser-based Gateway Controller application to configure and start the Gateway.

Note: Skip steps two and three if you are using Viz Pilot Data Server. Please see (Backend
Configuration) for more information about setting up a Viz Pilot Data Sever connection.

This section contains information on the following topics:

« Repairing or Removing the Gateway

« Installing Gateway
« Installing Database Client

Copyright © 2024 Vizrt Page 12
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4.1 Repairing Or Removing The Gateway

4.1.1 Torepairor remove the Gateway

+ Inthe Windows Control Panel, select Add or Remove Programs, locate the Vizrt Media Sequencer and use
the standard Modify >Repair/Uninstall options.

Copyright © 2024 Vizrt Page 13
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4.2 Installing Gateway

1. Fetch the Media Sequencer installer from download.vizrt.com.
a. All customers with a valid support contract have access to this area. Please contact your Vizrt
Customer Support if you need credentials/password.
b. Use your preferred FTP Client or the web-based interface at https://download.vizrt.com/ThinClient/
c. Navigate to /products/VizMediaSequencer/LatestVersion and select either
MediaSequencer-x64-<VERSION>.msi or MediaSequencer.Bundlelnstaller-5.5.1.28608.¢exe.

Note: It is recommended to verify the checksum of the downloaded installer before attempting to
install.
2. If an existing Media Sequencer is installed on the server
a. Itisrecommended to make a copy of the existing Media Sequencer current state before uninstalling
any previous version.
Backup the current state by copying %PROGRAMDATA%\Vizrt\Media Sequencer\default.xml to a safe
location.
b. Uninstall with Windows > Control Panel > Programs and Features.
3. Runthe MSlinstaller or bundle installer from Step 1.
a. MSlInstaller: Select the optional Gateway Component, as shown below:

ﬁ' Vizrt Media Sequencer -

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

e B =] Vizrt Media Sequencer The Gateway component
(=0 = | Main companents
(=3 = | Documentaton

=T [ Gateway |
= Will be installed on local hard drive

=18 Entire feature will be installed on local hard drive

=0 Feature will be installed when required

¥ Entire feature will be unavailable

I
|
| Reset | |[Dskisage | | Back [ et | | Concel |

b. Bundle Installer: Select Gateway controller as shown below:

Copyright © 2024 Vizrt Page 14
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€9 Media Sequencer

Version 5.5.0.28449

Install options:

Vizrt Media Sequencer
Documentation
Gateway controller

Desktop Shortcut

Vizrt Media Sequencer Location

CAProgram Files vedia Sequencer

4. Itisrecommended to make sure that the Media Sequencer service launches and starts automatically at
system start.
a. Afterinstalling Media Sequencer, double-click the Media Sequencer icon on the Windows desktop, or
from the start menu.
b. Select All Programs > Vizrt > Media Sequencer.
c. Inthe Media Sequencer Launcher panel make sure that the option Launch on system restart is
selected.
5. You can make sure that the Media Sequencer is correctly installed and working by connecting to the Media
Sequencer HTTP server.

Open your web-browser and connect to port 8580 , for example: http://localhost:8580

Copyright © 2024 Vizrt Page 15
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4.3 Installing Database Client

This section describes how to install and test the Oracle Database Client version 19c. For further documentation,
please see the Oracle Documentation website:

« https://docs.oracle.com/en/database/oracle/oracle-database/19/install-and-upgrade.html

Note: Installing the Oracle Database Client is not necessary if you are connecting to Oracle or Graphic Hub
via the Pilot Data Server.

0 Important! A 64-bit Oracle Database Client is required (Media Sequencer is a 64-bit application)

This section has more information about these topics:

+ Pre-installation

« Installing the Oracle Database Client

+ Language Setting for the Oracle Database Client
+ Testing the Installation

Also see the Oracle software and documentation.

4.3.1 Pre-installation

« Before installing Gateway, check the language settings for the Oracle Database Client. The National
Language Support (NLS_LANG) parameter must be the same as on the Vizrt database.

« If thereis an existing Oracle Database Client installed, create a backup of the tnsnames.ora file.

« Remove any previous or older versions of the client.

+ Acquire the archive of the Oracle Database Client version 19c. See Oracle documentation for information
about obtaining the software.

4.3.2 Installing the Oracle Database Client

Note: The installation procedure below is according to Oracle Database Client version 19c. References to
other versions can be found on the Oracle web site.

1. Logon as a member of the Administrators group to the computer on which to install Oracle components. For

installations on a Primary Domain Controller (PDC) or a Backup Domain Controller (BDC), logon as a

member of the Domain Administrators group.

Extract the Oracle Database Client to an appropriate folder, for example "C:\oracle"

Double-click the installer (setup.exe).

4. Follow the instructions to install the Oracle Database Client. The default settings during install should be
suitable.

w N

Note: Do not use the Oracle Net Configuration Assistant (NetCA) unless there are specific client connection
configuration needs. Using the NetCA is beyond the scope of this guide.
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5. After completing the installation, make sure that the correct language settings are configured. See section
Installing Database Client#Language Settings for the Oracle Database Client.

4.3.3 Language Setting for the Oracle Database Client

1. Start the Registry Editor (regedit) from the Start menu.
« Open the Start menu, enter regedit, and open the Registry Editor.
2. Open the path \HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY...<version>.

Mame Tvpe Data
{DeFauIt]l REG_SZ {walue nat set)
I"-.ILS_LF'.NG REG_5Z AMERICAN _AMERICAWESMSWINIZSZ
i oy
Edit Strin ? 83
& . 1_homez
Walue name; 2. Mclient_2
NLS LAME KEY _OraClient10g_homez
Yalue data; 2. Ohclient_2\dbs
AMERICAMN_AMERICA AL32UTFH
l k. ] [ Cancel ]

3. Double-click the registry setting for NLS_LANG.
4. Edit the string and change it to AMERICAN_AMERICA.AL32UTF8, and click OK.

Note: To help give Vizrt customers the best possible support, American English is chosen as the default
language for log messages.

4.3.4 Testing the Installation

1. Starta command-line tool, and type the following:

sqlplus userid/password@tnsname

2. If aTNS name alias is not configured, it is also possible to use an easyconnect string:

sqlplus userid/password@hostname/SID

3. Check that the output is similar to the example output below:

> sqlplus pilot/pilot@VIZRTDB

SQL*Plus: Release 19.0.0.0.0 - Production on Mon Mar 18 15:33:22 2024
Version 19.3.0.0.0
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Copyright (c) 1982, 2019, Oracle. All rights reserved.
Last Successful login time: Mon Mar 11 2024 14:44:58 +01:00
Connected to:
Oracle Database 19c Standard Edition 2 Release 19.0.0.0.0 - Production
Version 19.3.0.0.0
SQL>
See Also

« Installation
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5 User Interface

This section describes the user interface of the Gateway Controller Client. The client is a configuration and status
information tool that enables the user to configure and monitor the traffic on the Gateway server.

5.1 User Interface Overview

o) Gateway

+ (1): Top menu containing the active configuration tabs. See Tabs.

+ (2): Click Help to access the Gateway Administrator Guide.

+ (3): Main configuration window. The content shown here depends on the selected configuration tab.
+ (4): Filter message types shown in the log message window (5), and a button to clear the message log.
+ (5): Log message window. See Log Message Window.

« (6): Start, Stop, and Restart buttons. See Start, Stop and Restart Gateway Buttons.

+ (7): Gateway license status.

« (8): Status indicators. See VGG-Status Indicators.

This section contains the following topics:

« Tabs

« Status Indicators

« Log message window

« Start, Stop and Restart Gateway buttons
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5.2 Tabs

The Gateway Controller Client user interface contains eight top menu tabs.

O} Gateway

Each tabis explained in its own section listed below. Click the corresponding links to learn more about the tabs and
how to use them:

+ General Configuration

+ Backend Configuration
« Routing

+ Failover Settings

« Active Connections

« Active Running Orders

« Control Station Backup

+ NCS Server Configuration
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5.2.1 General Configuration

The General configuration tab contains Gateway’s basic settings.

O Gateway

General Config Backend Config NCS Server Config Routing Failover Settings Acti

Basic Settings

Mos Lower Port: 10540 Reconnect Interval :
Mos Upper Port: 10541 RO Days To Live :

Control Station Port: 10640 Heartbeat Interval :

Log Heartbeat/KeepAlive Messages : E] KeepAlive Interval :

Object Timebase :

Basic Settings

The following settings are global settings used by the Gateway.

MOS Lower Port: A listener port that the NCS connects to for sending media object related messages to the
Gateway.

MOS Upper Port: A listener port that the NCS connects to for sending rundown related messages to the
Gateway.

Control Station Port: A listener port that the control station Media Sequencer will connect to for
communicating with the Gateway.

Log Heartbeat/KeepAlive Messages: Adds heartbeats as well as keepAlive messages to the Media
Sequencer log file. The full MOS message will be logged when this setting is enabled.

Reconnect interval (sec): Specifies the number of seconds that Gateway should wait, when the connection
is lost, before trying to reconnect to the newsroom system(s).

RO days to live: Sets the number of days the routing between a running order ID and a control station IP
should live. Gateway clears out all running orders that have not been updated for a given number of days.
For details, see Active Running Orders section on active running order routing.

Heartbeat Interval: Sets the interval for how often heartbeat messages are sent to the NCS. 30 seconds is
recommended.

KeepAlive interval: Sets the interval for how often keepAlive messages are sent to the NCS. KeepAlive
should not be sent more frequently than every 30 seconds.

Object Timebase: Sets the sampling rate of the object in samples per second. For PAL Video this would be
50. For NTSC it would be 60.
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MOS 4 Websocket Server Settings

iC Authentication

ure Connections

+ Use Basic Authentication: Whether incoming websocket connections from NCS servers or control clients
need to authenticate with username and password.

+ Reject Insecure Connections: Whether to reject incoming unencrypted websocket connections and require
clients to connect using secure websocket.

« Username: The username for authenticating incoming connections when Use Basic Authentication is
enabled.

« Password: The password for authenticating incoming connections when Use Basic Authentication is
enabled.

How to Enable Settings
Enable settings by:

1. Edit a Basic Settings field.

2. Click the Apply Settings button.

3. Restart the Gateway.

4. The settings take effect when the Gateway is started.
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O Gateway

:eneral Config

T ™ Ty Tad
Basic Settings

Mos Upper Port :
Control Station Port :

Log Hearbeat Messages :

Apply Settings Cancel 5ettings
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5.2.2 Backend Configuration

The Backend Config tab is where you select which backend to use to send meta information about MOS objects to

the newsroom system (NRCS).
The tab has three options:

« Disabled
« Viz Pilot Data Server
« Oracle

Disabled

When selected, the Gateway does not send any information about our MOS objects to the NRCS.

oY Gateway

General Config lackend Config

Q Disabled Pilot Data Server Oracle

Viz Pilot Data Server

To use Viz Pilot Data Server as backend, enter the service document URI.

Y Gateway

General Config Backend Config

Disabled 0 Pilot Data Server Oracle

Service Document :
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For example, add the base URL includin

oY Gateway

the port (http://hostname:8177/), as shown below.

General Config Backend Config

Disabled O Pilot Data Server Oracle

Service Document :

A\ Note: Viz Pilot Data Server can be configured to use either Viz Graphic Hub or Oracle. Make this selection
when installing Viz Pilot Data Server. For more information see the latest Viz Pilot User Guide.

Oracle

Select this option to use a direct Oracle connection as backend.

kend Config

Disabled Pilot Data Server 0 Oracle

schema Mame :  PILOT
changeme
User : changeme
Password

y | E] N Ml el o Ll
Log DB Messages

Description of parameters:

« Schema Name: Enter the database schema name. Schema names are case sensitive. The default schema
name is PILOT and must be upper case.
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Note: Default username, password and schema name for Viz Pilot is PILOT. For security reasons, the
default password should be changed.

SID: Either enter a TNS name alias or a connection string. For the TNS name alias to work,
Oracle’s tnsnames.ora file must be edited.

Example: Alternative connection strings are <hostname>/<SID> or <IP address>/<SID>.

User: Enter the database username. Username is not case sensitive.
Password: Enter the database password. Password is not case sensitive.
Log DB Messages: Check this option to enable DB message logging.

Note: Use of Extended Advanced Queuing (AQ) is automatically checked by Gateway.
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5.2.3 Routing

The Routing configuration enables the user to manually configure Gateway to route messages to a specific control
station. Whenever routing entries are added or removed, the Gateway server must be restarted for the settings to
take effect.

For routing to have an effect, Enable AutoActivation must be enabled as part of the NCS Server
Configuration (Advanced Settings).

Gateway does a lookup in the mapping table to match the running order channel (roChannel) used by the
newsroom system. If the channel name is found, it uses either the MSE ID or TCP IP address to forward the message
and subsequent messages from the newsroom system to the control station.

Routing

o) Gateway

msi
10.11.1213

1. roChannel name: The roChannel name that identifies the control station. The roChannel name is set on the
NCS server, often through an NCS client.

2. Control Station Endpoint: Control station endpoint to use for the new roChannel routing.
« Currently connected control stations are shown in the dropdown list, but an MSE ID or a TCP IP could
also be typed manually for control clients not yet connected.
Add Route: Fill in the text fields, and click the Add Route button to add a new route.
Remove Route: Select a route from the list, and click the Remove Route button to remove the route.
5. Default Control Station Endpoint: If no routing is specified for a roChannel, and the default control station
endpoint is configured, messages with the roChannel will be routed to the default endpoint.

« Currently connected control stations are shown in the dropdown list, but an MSE ID or a TCP IP could
also be typed manually for control clients not yet connected.

W

A\ Note: All changes to the Routing table require that the Gateway is restarted.
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5.2.4 Failover Settings

o) Gateway

General Conf Backend Confi \ ol outin a ttin Active Conne S A 's ant tion Backup

1ain NCS IDACTve

Failover Settings enable the user to manually configure a failover setup between two NCSs. This means that the
Gateway routes messages to both NCSs. Whenever one or several new failover pairs are added or removed, the
Gateway server must be restarted for the settings to take effect.

A\ Note: Gateway’s failover setting is only supported by Associated Press’s Electronic News Production
System (ENPS) and for a limited use case for the Sobey Newsroom System.
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5.2.5 Active Connections

) Gateway

eral Config Backend Caonfig r Config Routing Fail
Port Rermote Endpaoint it incorm
C-client TEST roListall 4 i 09:10:02
TEST
TEST 2024-02-16T09:10:02
TEST
FOO
FOO roListAll
FOO

10.211.111.12 roRegAll 2024-02-16T09:06:04

The active connections tab contains a table of active connections with the following columns:

« Name: Name of the remote system, for example NCS ID or MSE ID.

« Type: Type of connection. For details, see the type definitions below.

« Port: TCP port used for an active connection.

» Remote Endpoint: Either an ID identifying the remote system (for websocket connections), or the IP address
of the remote system (for TCP connections).

+ Last incoming msg: Type information for the last incoming message.

+ Last incoming time: Timestamp for the last incoming message.

+ Last outgoing msg: Type information for the last outgoing message.

+ Last outgoing time: Timestamp for the last outgoing message.

Connection Types
There are primarily three kinds of connections:

« Connections from the NCS to the Gateway
» Connections from the Gateway to the NCS
« Connections from a Media Sequencer control station to the Gateway

NCS Connections

The connections to/from the NCS are directional. On a single connection there is one client endpoint and one server
endpoint. The client endpoint sends request messages to the server endpoint, and the server endpoint replies with
response messages. The following connection types are used for NCS connections:

+ NCS-RO-client
+ Connection with message flow direction from the Gateway to the NCS.
« Connection can be established by the NCS if configured to use client passive mode, otherwise the
Gateway establishes the connection to the NCS.
+ Used for rundown related requests from the Gateway, for example roReq or roReqAll messages.
« NCS-RO-server
« Connection with message flow direction from the NCS to the Gateway.
» Connection can be established by the Gateway if configured to use server passive mode, otherwise
the NCS establishes the connection to the Gateway.
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« Used for pushing rundown related information from the NCS, for example roCreate or roDelete
messages.
+ NCS-MOS-client
+ Connection with message flow direction from the Gateway to the NCS.
« Connection can be established by the NCS if configured to use client passive mode, otherwise the
Gateway establishes the connection to the NCS.
« Used for pushing information about available MOS objects to the NCS, for example mosObj
messages.
+ NCS-MOS-server
+ Connection with message flow direction from the NCS to the Gateway.
« Connection can be established by the Gateway if configured to use server passive mode, otherwise
the NCS establishes the connection to the Gateway.
+ Used by the NCS for requesting information about available MOS objects, for example mosReqObj or
mosRegAll messages.

Connections made from the Gateway to an NCS server are kept alive while the Gateway is running, and
automatically reconnect if the connection is closed. Connections from NCS servers to the Gateway may not be
permanent. Some NCS servers defer establishing the connection until a message is to be sent, and may close the
connection shortly after. In this case an active connection will only be shown in the table while the NCS is sending a
message.

Control Station Connections

Each Media Sequencer control station establishes a single connection to the Gateway used for bi-directional
communication with the Gateway. The connection type for Media Sequencer control stations is MSE-client. The
control station might send roReq messages to request a rundown from the gateway. The gateway will keep track of
which rundown is routed to which control station, and send information about available rundowns and routing to
all control stations. When a rundown is routed to a control station, the Gateway will route messages from the NCS
related to rundown content to this control station, for example roCreate, roList, or roElementAction messages.
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5.2.6 Active Running Orders

0} Gateway

anfig Backend Config N nfig Routing Fail S Active Connectians Active RO's Control Station Backup

* Remote Endpoint

Morning neus 2024-Feb-16 10.211.111.12

The Active Running Orders tab contains a table of Running Orders (RO) for each NCS server, with the following
columns:

« Slug: Descriptive name of the RO.
+ Timestamp: Time when the RO was last modified. The RO will be cleared if it has not been updated for a
number of days, as configured with the RO days to live setting under General Configuration.
+ Remote Endpoint: If specified, the RO is routed to the control station with this remote endpoint.
« Either an ID identifying the control station (for websocket connection), or the IP address of the
control station (for TCP connection).

The list of running orders can be expanded and collapsed per NCS server, by clicking the arrow icon left of the NCS
ID. Note that the list of active RO's will only contain RO's that the NCS servers have sent to the Gateway. There may
exist RO's on an NCS that has not been sent to the Gateway, for example if an RO is not active, or an RO for a
different MOS ID.
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5.2.7 Control Station Backup

o) Gateway

test-backup
1I3H.1'-‘_13 10.11.12.14

The Control Station Backup panel allows you to manually configure a backup Control Station endpoint. The
backup Control Station endpoint receives the same rundowns (and updates) as the main Control Station endpoint.
This means that changes seen by a client connected to the main Control Station endpoint show up for clients
connected to the backup Control Stations endpoint, and in turn means that any changes made during a live show
are reflected in the backup client. If the Control Station endpoints have been configured to send status information
back to NCS, status messages are only sent from the main Control Station.

Working with a Control Station

Adding a Backup Control Station

To Add A Backup Control Station

1. Enter Main Control Station Endpoint.
2. Enter Backup Control Station Endpoint.
3. Click Add Backup.

A control station endpoint is either an ID of a Media Sequencer connected to the Gateway with a websocket, or an IP
address of a Media Sequencer connected to the Gateway over TCP. All currently connected control stations will be
listed in the drop-down list when entering endpoints, but it is also possible to enter control stations not yet
connected to the Gateway manually.

Removing a Backup Control Station

To Remove A Backup Control Station

1. Select anitem under Control Station Backup.
2. Click Remove.
3. Click OK to confirm the removal of the Control Station backup item.

A\ Note: When adding or removing a single or several new backup Control Stations, the Gateway server must
be restarted in order for the settings to take effect.
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5.2.8 NCS Server Configuration

The NCS Server configuration tab is divided into three panels namely the Name (NCS ID), Basic Settings, and
Advanced Settings:

« Name (NCS ID) Panel
+ Active NCSs
+ Toadd anewNCS
» Tocreate a duplicate NCS
« Toremove an NCS
« Basic Settings
« Selecting MOS Protocol Version
» NCS Server Settings MOS 2.6.0 - 2.8.5
« NCS Server Settings MOS 4.0.0
» Advanced Settings

o) Gateway

° Tip: Whenever a setting is changed, click the Apply Settings button to enable the new settings. This also
requires the Gateway server to be restarted. All settings are individual settings for each Newsroom
Computer System.

Name (NCS ID) Panel

The Name (NCS ID) panel contains the list of NCS servers that are configured to be handled by the Gateway. The
Gateway is able to connect to multiple NCSs from different vendors.
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XAMPLE

Active NCSs
Click the Active checkbox to decide which NCS configurations take effect.
If an NCS is inactive:

« No connections are established to this NCS.
» Any messages the NCS sends to the Gateway are not recognized.

To add a new NCS

1. Click the + Add New button.
2. Enter the newsroom system’s ID (NCS ID).
3. Click OK.

To create a duplicate NCS
Create a new entry based on the settings of an existing entry.

1. Select the NCS you want to duplicate.
2. Click the Duplicate button.

3. Enterthe NCSID.

4, Click OK.
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To remove an NCS

1. Select an item from the NCS Server list.
2. Click the Remove button.
3. Click OK to confirm the removal of the NCS.

A\ Note: All changes to the NCS Server list require that the Gateway server is restarted.

Basic Settings

The basic settings depend on which MOS version is used for the communication between the Gateway and an NCS
server. Two examples, i.e., one for MOS 2.6.0 - 2.8.5 and one for MOS 4.0.0, are shown below.

+ MOS Version
« Server IP (MOS 2): NCS IP address
+ NCS Passive Mode (MOS 4): Passive connections allow either the Gateway or the NCS to be behind a
firewall.
+ With client passive mode, the NCS server will create all connections to the gateway.
« With server passive mode, the Gateway will create all connections to the NCS server.
« If disabled, both the Gateway and the NCS server will create connections.
+ Websocket Server URI (MOS 4): Base websocket URI that the Gateway will use to connect to the NCS.
« Notin use for client passive mode.
« MOS ID: Identifier for the Gateway.
+ Moslist Day Count: Specifies how old a data element can be in order to be forwarded to the newsroom
system and shown in the newsroom client.
» Send Heartbeats: Check this option to enable the Gateway to send heartbeat messages to the NCS. An error
is logged if a response to the heartbeat message is not received within a timeout period.
+ Send keepAlive (MOS 4): Check this option to enable the Gateway to send keepAlive messages to the NCS.
These messages are used to keep websocket connections alive.
+ Use Basic Authentication (MOS 4): Enables basic authentication, i.e., username and password
authentication, for websocket connections from the Gateway to the NCS server.

Selecting MOS Protocol Version

When configuring settings for a specific NCS server, you may need to change the MOS protocol version that should
be used for communication between the Gateway and the NCS server. This is done from the drop-down list in the
Basic Settings section.

Basic Settings

Mos Wersion :

Server P :

Moslist Daycount :

Send Heartbeats :
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Depending on the selected MOS protocol version, different settings are visible, as some settings may be unused for
that particular protocol version. For example, from MOS versions 2.6.0 until 2.8.5, settings related to establishing
TCP connections are shown. For MOS 4.0.0 and later, communication is done over websocket, so different
connection settings will be visible.

The Gateway supports the following versions of the MOS protocol:

« 2.6.0
« 2.8.0
« 28.1
¢ 282
+ 283
« 284
« 285
+ 4.0.0

In order to support MOS Protocol version 2.8.1 or later, both the Media Sequencer hosting the central Gateway and
Media Sequencer clients must be upgraded to version 5.3 or later. To support MOS Protocol version 4.0.0, the
Gateway must be upgraded to 5.6 or later.

NCS Server Settings MOS 2.6.0 - 2.8.5

NCS Server Settings MOS 4.0.0

Advanced Settings

+ MOS Lower Port (MOS 2): Specifies the socket port that the NCS is listening on for MOS Object messages
sent from the Gateway. The Gateway automatically establishes a connection to this port during startup.
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MOS Upper Port (MOS 2): Specifies the socket port that the NCS is listening on for rundown related
messages sent from the Gateway. The Gateway automatically establishes a connection to this port during
startup.

Use UTF-8 (MOS 4): Whether the communication with the NCS should be encoded as UTF-8. Only enable
this if the NCS server expects UTF-8 encoding instead of the default UCS-2 encoding as specified in the MOS
protocol.

Connection Timeout: Sets the number of seconds Gateway waits for a response to a request. If a response
message is not received within a given time, the next message is sent. This prevents messages

from clogging the system.

Msg Per Sec: The number of messages per second Gateway sends to the NCS. Specify value 0 for free flow

of messages.
Include data in MosObj: Check this option to include data field information in a MOS external meta block
inside all MOS object messages sent to the NCS.

Note: This information is typically used by NCSs either to present this information in their end-user
interface or to deduce key information that may be used for archiving purposes.

Include continue in MosObj - Check this option to include continue count information in a MOS external
meta block as part of the MOS Object messages sent to the NCS.

Note: This information is typically used by automation systems to trigger graphics. A continue count tells
the graphics operator how many times to press continue to play graphics scenes from start to finish.

Include mediainfo in MosObj - Sends metadata related to data elements containing video clips.

Note: This information is typically used by NCSs either to present this information in their end-user
interface or to deduce key information that may be used for archiving purposes. This setting only works for
old Viz Link based systems.

Enable Autoactivation: The Enable AutoActivation option for the newsroom system must be enabled in
order for Routing to have an effect. This enables the control station to activate a running order without an
initial request.

Push Moslist: Check this option to enable sending a MOS Object list message to the NCS to synchronize the
list of MOS Objects.

Send MosObj: Check this option to enable sending of MOS Object messages to the NCS when a MOS object is
created, updated or deleted.

Push Moslist Once: If Push Moslist is enabled, check this option to only send the MOS object list once, even
if the connection between Gateway and NCS has been down.

Always Respond With MosObj: If the NCS requests the MOS Object list, enabling this setting sends
individual MOS Object messages in place of a big list of all MOS objects.

Accumulate Running Order List: Check this option to let the Gateway maintain the list of active running
orders, in place of asking the NCS for the list each time it is needed.
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5.3 Status Indicators
7/

Connection ¥~ DB Connection

Running ¥

The client has three status indicators using visual status icons:

« Connection: Indicates if the Gateway Controller Client has a connection to the Gateway server.
« DB Connection: Indicates if the Gateway server has a connection to the database.
+ Running: Indicates if the appointed Media Sequencer is configured and running as a Gateway server.

5.3.1 Visual Status Icons
Connected visual status icon.

=
Not connected visual status icon.
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5.4 LogMessage Window

The Log Messages window contains the following areas:

+ Log Traffic Checkbox
« Clear Logs Button
+ Messages Area

erbose
rbose

roose 2 -02-16T11: - BGO-ENPS-ALPHA

-02-16T11: - .111.49 We sent internal message mosGateway

.111.49 We sent internal message roListAll
MPS-ALPHA
oming connection from endpoint: ‘BGO-ENPS-ALPHA,
verbose 24-0: :38:44 ( Wes heartbeat

rbose z -38:44 ( | en ge heartbeat

5.4.1 Log Traffic Checkbox

Log Traffic

Type Time

Enable the Log Traffic option to log the traffic between the newsroom systems, control stations, and the Viz Pilot
database. This setting is disabled by default.

Check this option to log all MOS messages received, sent, and forwarded by Gateway. The traffic messages will be
part of the media sequencer log file located under: C:\ProgramData\Vizrt\Media Sequencer.
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5.4.2 Clear Logs Button

Log Traffic #Z Errors (0) Warnings (0) Messages (0) “Z Verbose (150) Clear Logs

Using the Clear Logs button, all log messages currently displayed in the log messages window can be cleared.

5.4.3 Messages Area
The messages area consists of four columns containing pieces of information about the message:

+ Type: Shows the type of log message received.

» Time: Shows a message time stamp (year-month-dayThour:minute:second).

« Source: Shows which system issued the error, warning, info, or notice message.
+ Message: Displays the content of the message.

° Tip: Hover the mouse pointer over a message to see the full content of the message.
# Errors (0} Warnines (0}

rbose : ; E GO-ENPS-ALPHA
rbose : :56: )-ENPS-ALPHA
NPS-ALPHA
NPS-ALPHA

BGO-ENPS-ALPHA
-02-16T11:55:4¢ BGO-ENPS-ALPHA
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5.5 Start, Stop And Restart Gateway Buttons

Depending on the current run status you can use the buttons in the lower left corner of the interface to Start,
Restart, or Stop the Gateway:

« Starting the Gateway
« Stopping the Gateway
+ Restarting the Gateway

When Gateway is running, the following buttons are visible and enabled:

If the MSE_VIZGATEWAY license has expired, the Start button is disabled if the gateway is stopped.

Similarly, the Restart button is disabled if the gateway is running when the license expired.

5.5.1 Starting the Gateway

Start the Gateway Client when it is stopped.
1. To start Gateway, click Start.

Log Traffic Z Errorsio Warninezs 1ol ges(95] “E Verbose(d

Type Tirme Source
-, info 2022-03-11711:20:31 VizGateway 5 AT e Y.

-info 2022-03-11710:14:39 Wiz Qateway Gateway Initialized

-, info 2022-03-11T09:44:51 WizGateway izGateway Initialized

(1) start Gateway licensed urtil: 21 05-31T1 40000+ 0200

2. A message appears in the messages area confirming that Gateway has started.
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= Werbose Q)

Log Traffic # Errorsioi

Warninzs i Messazes 194
Type Time Source heszzaoe
info 2022-03-11T10:14:39 izGateway  WizGateway Initialized
7 info 03-11T709:44:51 ! atewvay iZGateway inimalized

-, info A022-03-11T02:4017 Wizoateway  WizGateway Initialized

(1) stop 2% Restart Gateway licensed urtil: 2022-05-31 T1 4:00:00+ 0200

5.5.2 Stopping the Gateway
Stop the Gateway Client when it is running.

1. To stop Gateway, click Stop.

: Verbose

Log Traffic # Errorsioi Warninzs 0

Type Tirne Source

-7 info 2022-03-14T11:1 233 Vizhateway S g gateway.

- info 2022-03-14711:09:10 WizGateway VizGateway Initialized
-, info 2022-03-14711:09:03 WizGateway Stopping gateway.

-7 info 2022-03-14711:08:41 WizGateway VizGateway Initialized

(') start Dateway licensed urtil: 2 05-271T1 4:00:00+ 0200

5.5.3 Restarting the Gateway

Restart the Gateway client when it is running.

A\ Note: Refreshing the browser does not restart the Gateway; this only reloads the page.

1. Click Restart.

(') stop 1% Restart Gatevway licensed urtil: 2022-05-317 71 4:00:00+ 0200
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2. You receive a message that Gateway is stopping, followed immediately by another message that Gateway
was initialized again.

Log Traffic # Errorsid Warnines (01 = Verbose (Ol
Type Tirne source

| info 2022-03-14T11:16:55

[ infa 2022-03-14T11:16:55

| info y 03-14T11:15:32

[ infa 3-14T11:12:33

| info : 3-14T711:09:10

i info : 3-14711:09:03 Viziateway  Stopping gateway.

(1 =top 1% Restart Gateway licensed until: 05-31T1 4:00:00+ 0200

° Tip: Please keep in mind that changing some Gateway configuration settings requires a restart in order for
the changes to take effect.
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6 Configuration

This section describes how to configure the Gateway server, and the control stations. Before any configuration can
be done, information about the NCS servers and database must be obtained.

This section contains information on the following topics:

+ Pre-Configuration

« Viz Pilot and Viz Trio Gateway Configuration

« NCS Specific Considerations

« Launch Standalone MOS Config Web-Application
« Viz Multiplay Gateway Configuration

« Gateway Server

« Secure Communication
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6.1 Pre-Configuration
From the NCS, obtain the following information:
+ NCSID, NCS server IP, MOS version, and MOS ID.
To use the Oracle database as a backend, obtain the following information:
+ Oracle System Identifier (SID), username, password, and UTF-8 character encoding.
To use the Pilot Data Server as a backend, obtain the following information:
« Base URL and the port number for the Pilot Data Server: http://hostname:8177

If the Gateway is installed on another host than the Oracle database, the hostname of the database must be used in
addition to the SID (<hostname>/<SID>).

+ To test the database connection, try typing tnsping hostname/SID on the command-line.

Port numbers used in screenshots in this document are standard port numbers used in the MOS Protocol. Other
port numbers may be used.
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6.2 Viz Pilot And Viz Trio Gateway Configuration
All content control applications use the same settings to connect to the Gateway and Pilot database.
To access these settings, use the following menu options:

+ Viz Pilot: from the main menu open Tools > Media Sequencer Configuration, and make changes in the
Database and MOS tabs.

+ Viz Trio: from the main menu select File > Configuration and make changes in the Pilot Database and
Connectivity > MOS sections.

6.2.1 Gateway Configuration for Viz Pilot

B External Interfaces

10_.211.112.37_ 10640
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6.2.2 Gateway Configuration for Viz Trio

i Trio Configuration

User Interface
Gareral
Keyboard Shortcuts and Macros
Text Editar
Page List/Playlist
Paths
Local Preview
User Restrictions

Output
Viz Graphic Hub

0_.211.112.37_ 10640

VCP Database S IC z
patabase Settings Newsax

Picture Database

Connectivity
_ W Sendd snmnn=] sosizinarisng Sringsslzene e e
Intelligent Interface
GPT
VDR
MCL/AVS
Socket Object Settings
Proxy
Wiz One

ImportfExport Settings

6.2.3 Gateway Configuration in Standalone Mos Config Web-Application

It is possible to use the standalone web application for configuring Gateway settings. See the Launch Standalone
MOS Config Web-Application section for further information.

6.2.4 Database Settings

Database settings can be configured using a configuration web application hosted by the Media Sequencer. With
recent versions of Viz Pilot and Viz Trio, this web application will be used for database configuration. It is also
possible to open the configuration web application from a web browser on the control station, with the address:
http://localhost:8580/app/pilotdbconfig/pilotdbconfig.html.
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Pilot DB Status

A Flease figure how Media Sequencer should conned to Filot DE.

Pilot DB Settings

©rilot Data Server
DataServer:  hitp: N Conneding..

COracle

Immediately remove deleted elemerts

Pilot Data Server

Configure the Pilot Data Server service document URL, in order to connect to a Pilot Data Server.

Oracle Database
For a direct connection to an Oracle database, configure the following settings:

« Connection string: Sets the connection to the database.

A\ Note: Use the following string format: user-name/password@database.

« Schema: Shows the name of the Oracle schema.

A\ Note: The Schema name is case-sensitive, typically given in uppercase.

6.2.5 Gateway Connection
For Viz Pilot and Viz Trio, these buttons are available under the MOS tab.

« Start: Starts a connection to Gateway server.
« Stop: Close a connection to Gateway server.
+ Restart: Restarts a connection to Gateway server.

6.2.6 Gateway Connection Configuration
For Viz Pilot and Viz Trio, these settings are available under the MOS tab.

+ Automatic reconnect: Starts the Gateway connection automatically when starting or resetting the Media
Sequencer.

Copyright © 2024 Vizrt Page 48



Gateway Administrator Guide - 5.7

Reconnect interval (sec): Specifies the number of seconds that the Media Sequencer should wait, when the
connection is lost, before trying to reconnect to Gateway.

Gateway Host: Shows the IP address of the Gateway host.

Gateway Port: Shows the port number on the Gateway host.

Note: MOS ID and NCS ID are legacy settings that may be left empty, as they will be ignored. MOS ID and
NCS ID can be configured in NCS Server Config on the Gateway.

Send item stat: Sends feedback to the NCS via MOS, for example information about the transfer status of
elements.
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6.3 NCS Specific Considerations

This section describes some NCS-specific considerations that must be taken into account when configuring
Gateway with an NCS. For other NCSs, than the ones mentioned below, a generic configuration should be sufficient,
see the Configuration Section.

6.3.1 ENPS

Gateway supports an ENPS Buddy setup. Use the Failover settings to add a main and backup server.

Buddy Support

The ENPS NCS can be configured to run with an identical mirror server (called a "buddy") at all times, as a failover.
Gateway supports this setup, and offers a failover configuration in the Gateway Controller Client. This enables
Gateway to send messages to more than one NCS.

If the primary server fails or is down for maintenance, all messages are sent to the buddy server until the primary
comes back on-line. All changes received from the Gateway are queued on the ENPS buddy server, and copied back
to the main server automatically when it returns to production.

6.3.2 Avid MediaCentral (formerly iNews)

Note: Avid iNews version 2.6, and newer, can be used with Gateway. Older versions are not compatible.

There is no need to enable the DB connection for iNews. It does not need metadata about Vizrt MOS objects as it
only refers to the MOS object ID and not the entire MOS object.
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6.4 Launch Standalone MOS Config Web-Application

For setups where no Control Clients (Viz Trio/Viz Pilot Director) are part of the system, you can still launch a
standalone MOS Config web-application to configure your Control Station to connect to Gateway.

6.4.1 Setting up your Control Station as a MOS Client
The Media Sequencer running on your Control Station must first be configured to connect to a Gateway.

On the Control Station which runs the Media Sequencer, open the following page in a Web Browser: http://
localhost:8580/app/mosconfig/mosconfig.html .

Note: It isimportant that the URL above connects to the Media Sequencer running on the Control Station,
and not the Media Sequencer on the Gateway Server. See section Gateway Server for details on how the
Gateway Controller web-application is used to configure the Media Sequencer running on the Gateway
Server.
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O [ o localhost

Send avai

Send local chan

Send vi changed back to NCS

Auto-activate MOS Playli

ecure Communication

6.4.2 MOS Client Status

In this scenario, the MOS client is the Media Sequencer. The MOS client must be configured to communicate via the
MOS protocol with a Gateway.

« MOS Client Status shows whether the Media Sequencer is able to connect to the Gateway.
« You can also Start and Stop the local client.
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6.4.3 MOS Client Settings

+ Gateway Host: Hostname or IP of the machine running Gateway.

+ Advanced Settings: A drop-down menu in which advanced settings about the used port or MSE ID can be
made, if these should differ from default values.

+ Send available status back to NCS: Sends the available status for elements containing clips and/or images
back to the NCS as Ready or Not Ready.

+ Send local channel assignments back to NCS: It is possible to make last-minute changes to an element's
playout channel in Viz Multiplay. The Media Sequencer then sends this channel assignment back to the
newsroom system if this setting is enabled. If this setting is disabled, the local change may be overwritten on
the next update from the newsroom system.

« Send video status changed back to NCS: Sends the clip playback status (CUED, PLAYING, STOPPED) back
to the NCS.

« Auto-activate MOS playlists in profile: If no client application operates the MOS rundown (and if it is
controlled by an automation system, for example) you can auto-activate all MOS playlist for a specific
profile.

« Use Secure Communication: If enabled, the MOS client connects to the Gateway via a websocket secure
connection (MOS 4). Furthermore, a username and a password are required for the connection.

« Apply Settings: Applies the changed settings without closing the window. This button is only enabled when
changes have been made.

TCP Connection

Connecting a MOS client to the Gateway over TCP uses port 10640 by default. This could be changed using the
Advanced Settings drop-down menu, as shown below.
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MOS Client Settings

Gateway ; Hostname

Auto-activate MOS Playlists

Use Secure Communication

Websocket Secure Connection

Since MOS version 4.0.0, it is possible to connect a MOS client to the Gateway using a websocket secure connection.
For this, User Secure Communication must be activated. This setting additionally requires a username and a
password for establishing a connection, which can be entered in the two corresponding input fields below.

As shown in the Advanced Settings drop-down menu, port 8543 is used by default for websocket secure
connections. This setting, however, can be overwritten using the corresponding text field. Such secure connections,
furthermore, require a unique MSE ID. By default, the hostname of the machine on which the MOS client runs is
used, but the same Advanced Settings drop-down menu could be used to also overwrite this default setting.
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MOS Client Settings

ateway Host:  Hostname

Advanced Settings

Auto-activate MOS Playlists

lUse Secure Communication

Username :

F:'555"-.1"'."[:}'r[j . oo RRRRRORRE
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6.5 Viz Multiplay Gateway Configuration

Viz Multiplay can be used as a MOS client. This means that the rundown is created in a Newsroom Computer System
(NCS). The rundown can be transferred to the local Media Sequencer from NCS via Gateway and controlled by Viz
Multiplay.

6.5.1 Setting up Gateway to Act as a MOS Client

The Media Sequencer must first be configured to connect to a Gateway, which connects to multiple NCSs. All the
rundowns controlled by the Gateway will then be listed when you add an external playlist to a show in Viz Multiplay.

Open Settings > MOS Config:

tus changs

Auto-activate MOS Playlists

Use Secure Comrnunication

6.5.2 MOS Client Status

In this scenario, the MOS client is the Media Sequencer. The MOS client must be configured to communicate via the
MOS protocol to a Gateway.
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« MOS Client Status shows whether the Media Sequencer is able to connect to the Gateway.
« You can also Start and Stop the local client.

6.5.3 MOS Client Settings

+ Gateway Host: Host name or IP of the machine running Gateway.

+ Send available status back to NCS: Sends the available status for elements containing clips and/or images
back to the NCS as Ready or Not Ready.

+ Send local channel assignments back to NCS: It is possible to make last-minute changes to an element's
playout channel in Viz Multiplay. The Media Sequencer then sends this channel assignment back to the
newsroom system if this setting is enabled. If this setting is disabled, the local change may be overwritten on
the next update from the newsroom system.

« Send video status changed back to NCS: Sends the clip playback status (CUED, PLAYING, STOPPED) back
to the NCS.

+ Auto-activate MOS playlists in profile: If no client application operates the MOS rundown (and if it's
controlled by an automation system, for example) you can auto-activate all MOS playlist for a specific
profile.

« Apply Settings: Applies the changed settings without closing the window. This button is only enabled when
changes have been made.
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6.6 Gateway Server

Configuring the Gateway server can be done locally on the server host, where the Media Sequencer with the MOS
gateway functionality is installed, or remotely from a client machine using the Gateway Controller web-application.
In both cases, the web interface application is used.

 Activate the Gateway Server
+ Backend Config

« Newsroom Servers

« Routing

« Failover

+ Control Station Backup

6.6.1 Activate the Gateway Server

Connect to the Gateway at host <ADDRESS> (substitute <ADDRESS> with the actual hostname or IP address) by
browsing to the following web address: http://<ADDRESS>:8580/app/gatewaycontroller/gatewaycontroller.html

The first time the Gateway server is used, it needs to be initialized. Click the Start button, and the Media Sequencer
is enabled as a Gateway server. When the Gateway server is enabled the Running indicator indicates connection.

~ o e . - S
Connection = DB Connection "’ Running

6.6.2 Backend Config

The Gateway may be configured to synchronize meta data about Pilot data elements with the NCS. When enabled,
the Gateway will send MOS Object messages to the NCS containing meta data when Pilot data elements are added,
updated or removed. Based on this meta data, the NCS will typically provide a list of elements, which may be added
to stories by the user. The backend for providing Pilot elements can be configured in the Backend Config tab. Pilot
Data Server and Oracle database are supported as backend.

Pilot Data Server

The Pilot Data Server option can be used to connect to both of Viz Pilot's currently supported database backends:
Graphic Hub and Oracle.

The Pilot Data Server notifies the Gateway about changes in the database (using a STOMP based protocol with
fallback to polling the Pilot Data Server's change log). The Gateway generates MOS Object messages that are sent to
the NCS to synchronize metadata about the Pilot data elements.
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O Gateway

General Config Backen

Disabled Q Pilot Data Server Oracle

service Document -  hostname:817/

1. Click the Backend Config tab.
2. Select Pilot Data Server.
3. Enter the base URL with the port number: hostname:8177.

Oracle

The Oracle option is mainly used for Viz Pilot setups that are not running Pilot Data Server version 7.0 or later.

Stored procedures in the Oracle database backend notify the Gateway about changes to Pilot data elements in the

database. The Gateway generates MOS Object messages that are sent to the NCS to synchronize metadata about
the Pilot data elements.
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O ¥ Gateway

Backend Config

Disabled  Pilot Data Server ) Oracle

Schema Mame : Pl
D : changeme
User : changeme

Password :  =«exee-

1. Click the Backend Config tab.
2. Select Oracle.
3. Enter the Schema Name, SID (EZCONNECT) connection string, User and Password for the database.

A\ Note: The database Schema Name is case sensitive.

4. Check the Log DB Messages (optional).
5. Click Apply Settings.
6. Forchanges to take effect on the Gateway server, click Restart.

The procedure above should connect the Gateway server to the Viz Pilot database, switch the DB connected
indicator to green, and enable the Gateway server to receive messages from the database.

Q Important! Before configuring Oracle backend, make sure an Oracle Database Client is installed and
working. The Oracle Client version should match the Oracle Database in use.
If using a 64-bit Gateway, the Oracle Client must be 64-bit. Oracle uses the Windows PATH environment
variable to select which Client to use if there are several Oracle Clients installed.

6.6.3 Newsroom Servers

Click the NCS Server Config tab to configure the newsroom servers. Configuration is done per newsroom system.
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Cancel

If no newsroom system is added to the Gateway server, do the following:

1. Click the Add New button and the Create New NCS dialog appears.
2. Enterthe NCSID and click OK.
3. Select the newly added entry from the list of newsroom systems.

In the Basic Settings frame, change the following:

1. Enterthe server IP and MOS ID. The rest are optional settings.
2. Inthe Advanced Settings frame, different settings can be enabled or disabled depending on the newsroom
system in use.
When done click Apply Settings.
4. Click Restart for changes to take effect on the Gateway server.
Repeat the steps above to add all the needed newsroom systems.

w

° Tip: If the newsroom systems have the same setup, select a newsroom system from the list and click the
Duplicate button.

6.6.4 Routing

o) Gateway

General Config Backend Config MCS rer Config Routing ailover Settings Active Connections AT

roCharinel Marne - Contrel Station Endpaint :

Click the Routing tab to manually configure routing of running orders, also known as rundowns and playlists, to the
control station.

1. Configure the roChannel name and control station endpoint before clicking the Add Route button.

2. Forthe routing to take effect, click the NCS Server Config tab and check the Enable Autoactivation box for
the newsroom system that the running orders are automatically routed from.

When done, click the Apply Settings button.

4. Click the Restart button for changes to take effect on the Gateway server.

w

6.6.5 Failover

O} Gateway

Control Station Backup
e Fallover Pair

Main Server *  Backup Serve Alwar Main NCS 1D

[ INEWS4X
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The failover setting allows the Viz Gateway server to send its messages to more than one NCS system. For failover to
work, the newsroom system must be setup with a main and backup server accordingly.

To Set up Main and Backup Servers

1. Add amain and a backup NCS from the drop-lists.

Click the Add Failover Pair button.

The setting is set to Active after adding a pair.

The Always use Main NCS ID setting should be left inactive unless using the Sobey NSC system.
Click the Restart button for changes to take effect on the Viz Gateway server.

ok wn

>

Note: Currently, this feature is only supported by ENPS and Sobey.

6.6.6 Control Station Backup

o) Gateway

Rt test-backup
BH}H.'IE'IB 10.11.12.14

The Control Station Backup setting allows the Gateway to send each message that has been targeted to both a
specific control station and a backup control station simultaneously.

To configure:

1. Configure main and backup control station endpoints and click the Add Backup button.
2. Click the Restart button for changes to take effect on the Gateway server.

A\ Note: Itis possible to configure a system where two control stations are backup for each other.

As an example, assume there are two Media Sequencers as control stations: servers A and B. Now we take the
actions in the table below:

Action Result

Set server A as Main, B as Backup using the A is now Main, B is Backup.
Add Backup button.

Keep the definitions from the step above, and Both control stations A and B are updated with
now add B as Main and A as Backup. MOS messages, both are running.
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From a Viz client, such as Trio or Pilot,
connect to B and request a MOS playlist.

Shut down control station B.
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Result

Control station B becomes Main control station
now. Whichever control station requests MOS
playlist first, becomes Main control station. The
MOS playlist becomes available to both of the
control stations.

Control station A becomes Main and start
receiving and sending all the updates. Gateway
does not receive any message from Control
station B.
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6.7 Secure Communication

As of MOS Protocol version 4.0.0, it is possible to configure the Gateway for secure web socket communication.
Enabling secure communication between the Gateway, NRCS servers and control stations, the Media Sequencer
hosting the Gateway requires set up with HTTPS.

+ Prerequisites

+ Request Certificate from Certificate Authority
+ Self-signed Certificates

» Configuring the Gateway

« Configuring Control Stations

This section describes setup and configuration of Gateway with a certificate for secure communication over web
sockets. The recommended way to obtain a certificate is to request it from a Certificate Authority, though it is
possible to use a self-signed certificate instead.

6.7.1 Prerequisites

Gateway

Install the Gateway as described in section Installation.

OpenSSL

OpenSSL is used to create a self-signed certificate, and the optional Diffie-Hellman group. The OpenSSL tool is only
for creating the certificate files, it is not required to run Gateway.

The OpenSSL project does not distribute binaries, instead there are options for obtaining OpenSSL for Windows
from a third party.

To install OpenSSL

A standalone installer for OpenSSL for Windows is available at https://slproweb.com/products/
Win320penSSL.html.

« Download and run the latest Light version of OpenSSL for 64-bit Windows (either EXE or MSl installer can be

used).
————————————————————————————————————————————————————

Download Win32AWinb4 OpenSSL today using the links below!
File Type [
Winb4 OpenSSL v3.2.1 Light AMB Installer |l
EXE | MSI v

k
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Open an OpenSSL Command Prompt

After installing OpenSSL the tool will be available from an OpenSSL command prompt.
From the Windows Start menu navigate to the OpenSSL folder and click on the "Win64 OpenSSL command prompt"
shortcut for opening a command prompt with the OpenSSL tool available.

6.7.2 Request Certificate from Certificate Authority

The recommended way of obtaining a certificate for the Gateway is to request it from a Certificate Authority (CA).
Usually your company will manage a CA on the company network, for example by using Microsoft Active Directory
Certificate Services.

The procedure for obtaining a certificate may vary from company to company.

« Use your company's procedure to request a web server certificate, for the machine hosting the Gateway.
« The Gateway requires an X.509 certificate with separate certificate- and private key files in the PEM format.

6.7.3 Self-signed Certificates

It is also possible to use a self-signed certificate for secure communication to the Gateway.
However, this approach has the drawback that the certificate must be imported manually to all machines that
needs to connect to the Gateway securely.

To create a self-signed certificate

1. Openacommand prompt where the OpenSSL tool is available (see Setup Secure Communication#Open an
OpenSSL command prompt).

2. Atthe command prompt, change the directory to the location where you want to store the certificate files.
In this example, you store certificate files in the data directory of the Media Sequencer hosting Gateway.

> cd "%programdata%\Vizrt\Media Sequencer"

3. Create a self-signed certificate. In this example, the certificate expires 365 days from now.

> openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout gateway-key.pem
-out gateway-cert.pem

This command will generate a private key and certificate file in the current directory.

4, When prompted to provide company information, in the field Common Name, add the hostname used for
connecting to the Gateway.
As this is a self-signed certificate you can leave the remaining fields blank.

To import a self-signed certificate

This procedure works for Media Sequencer control stations connecting securely to the Gateway and NRCS servers
that use the trusted root certificate store for verifying certificates.

The certificate must be imported onto these client machines to enable connection of control stations and NRCS
servers to the Gateway that has been configured with its self-signed certificate.
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The certificate will be imported to the Windows trusted root certificate store.

1. Copy the self-signed certificate file to the client machine.

Note: Do not copy the private key or Diffie-Hellman group !
For security, these files must only reside on the Gateway.

2. With an administrator command prompt, import the self-signed certificate for the Gateway:
(replace gateway-cert.pem with the path to your certificate file, if different)

> certutil -addstore -f "Root" '"gateway-cert.pem"

6.7.4 Configuring the Gateway

All configurations are made in the Media Sequencer initial menu.

HTTPS

Create a Diffie-Hellman Group

This step is optional, but recommended to increase security. It creates a Diffie-Hellman group file used to provide
additional security.

1. From a command prompt where the OpenSSL tool is available (see Setup Secure Communication#Open an
OpenSSL command prompt).

Note: This command has a long execution time (approximately 10 minutes).

2. Use the following command to create a Diffie-Hellman group file in the current directory named "gateway-
dhparam.pem".

> openssl dhparam -out gateway-dhparam.pem 4096

Enable HTTPS

1. Open the Settings menu of the Media Sequencer launcher.
2. From the left-hand panel, select HTTPS.
a. Enable HTTPS.
b. Configure the HTTPS port.
c. Select the location of files for the certificate, private key and optionally a Diffie-Hellman group file.
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B Enable HTTPS
Port 854

Certificate (.permn) CAProgramData\wizri\Media Sequence  Browse...

Private key (.pem} C\ProgramData\wizrt\Media Sequence  Browse...

DH {optional) C:\ProgramDatawizrtiMedia Sequence

Cancel

3. Click Save.
4. (If the Media Sequencer is running)
You are prompted to restart the Media Sequencer for the changes to take effect.

Gateway Settings

Enable Secure Communication

1. Onthe MSE client, open the Gateway Controller (see Start the Gateway controller client).
2. Select the General Configuration tab.

This is where you configure the Gateway to use secure communication.

Usermame :

= TIIIIIL

3. Enable Reject Insecure Connections to ensure all websocket connections to the Gateway are encrypted.
4. (Optional) You can enable Use Basic Authentication and specify a username and password required to
connect to the Gateway over websocket.
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Note: When Use Basic Authentication is selected, control stations and NCS servers must be configured to
provide the username and password in order to successfully establish a connection to the Gateway.
Control stations and NCS servers must also connect to the HTTPS port for the Gateway instead of the
default port for unencrypted HTTP.

5. Apply the settings and restart the Gateway for the changes to take effect.

6.7.5 Configuring Control Stations

After setting up the certificate it should be possible to configure secure communication between the Gateway and
the Media Sequencer running on the control station.

If you are using a self-signed certificate for the Gateway, make sure the certificate has been imported as explained
in section Setup Secure Communication#lmport a self-signed certificate.

MOS Config Web Application

Configure the Control Station Media Sequencer

1. Use the MOS config web application to configure the control station Media Sequencer (see Launch
Standalone MOS Config Web-Application).
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2. Configure the Gateway hostname, enable secure communication and provide the username and password
configured for basic authentication against the Gateway.

If everything is configured correctly, the Media Sequencer should be able to establish a secure websocket
connection to the Gateway.

Troubleshooting

« If there are certificate errors when using a self-signed certificate, make sure the self-signed certificate has

been imported on the control station.
« If there are certificate errors when using a certificate from a certificate authority, make sure the client

machine knows about the root certificate.
« Verify that the client machine is connected to the domain.
« Make sure the hostname used for connecting to the Gateway is the same as specified when the certificate

was requested/created.
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7 MOS Protocol Support

7.1 MOS Profile Support

Gateway supports the following MOS profiles:

Profile Definition Supported Vizrt Comment

0 Basic Communications yes

1 Basic Object Based Workflow yes

2 Basic Running Order/Content  yes
List Workflow

3 Advanced Object Based partly Only mosltemReplace is
Workflow used.

4 Advanced RO/Content List yes
Workflow

5 Item Control partly Only roCtrl is supported.

6 MOS Redirection yes

7 MOS RO/Content List no
Modification

7.2 MOS Protocol Support
Gateway supports these MOS protocol versions:

Protocol version Supported

2.6 yes

2.8.0 yes

2.8.1 yes*

2.8.2 yes*
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Protocol version Supported
2.8.3 yes*

2.8.4 yes*

2.8.5 yes*

4.0.0 yes

*Both the Media Sequencer hosting the central Gateway and Media Sequencer clients must be
upgraded to version 5.3 or later to support MOS Protocol version 2.8.1 or later.

**The Media Sequencer hosting the central Gateway must be upgraded to 5.6 to support MOS
Protocol version 4.0.0. The Media Sequencer clients must be upgraded to at least 5.3, but in
order to support secure websocket communication with the central Gateway, the clients must be
upgraded to 5.6 as well.

See Also

« For more information about the MOS protocol, see mosprotocol.com.
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8 Installation Test

This section describes how to test the installation of Gateway with Vizrt content control applications such as Viz
Pilot and Viz Trio.

Content control applications usually do not edit playlists because a content control application is unable to update
the NCS. Changes on the control station could cause undesired effects in the playlist when a story is updated by a

newsroom system. However, Vizrt content control applications are capable of editing their own MOS Objects (also
known as data elements) if needed.

This section contains information on the following topics:

« Viz Pilot
e Viz Trio
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8.1 VizPilot
Channel 1 Channel 2 Channel 1 Channel 2
Example profile g E

Before running an installation test, check that all settings and see that the connection status in the content control
application is good.

« L[ Connection to the Viz Engine renderer is good (program or preview).

« ¥ connection to the video output is good (program or preview).

« = Connection to the database is good.

« B connection to the Gateway is good.

8.1.1 Request Running Order

DB playlists | MSE Playlists |
Mame h odified Prafile
- &5 MOS Playlists
=1 &5 TEMPS
Wizrt Flaylist [TERFS]
1 TINEWS

£ MENPSE0VI4
(£ BEMPSEVM4
£ MENPSE0VIA
(1 BEMPSEOVM3
Mew playlizt 11./9/2007 10:20: 48

£ ¥

MEFW EN

Note: In Viz Pilot, a running order is called a playlist.

1. Click the Playlists button on the control panel to the left.
2. Select the MSE Playlists tab.

o Information: All newsroom systems, represented by the NCS ID, that are connected to Gateway can be
seen in the list.

3. Select the newsroom system, and then select one of its running orders. Double-click the running order to
open and monitor it.
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B o @ B & @ @ 0o

Cue  Take Continue Takeout Init playlist Init selected CleanUp
Description | Template Id | Channel | Variant | Available |
~ [ First story & 100%

mos: @ Active HosT: 10.11.12.13 START: 5/15/2024 2:00:00 | curanion: 00:30:00 UPDATED: 3:20:17 PM
|Search QY <nofiter> 4|+ () Playlist Active VDCP OFF

v

4. Verify that MOS status in the lower left says "Active" and has a green checkmark, indicating the playlist is
MOS active. If not, i.e., it says "Inactive" and is red, right-click on the icon and select Request.
5. Check that the playlist has the same story and items as the one created in the NCS.

B a3 @ B & @ B @loom

Cue  Teke Continue Takeout Init playlist Initselected CleanUp

Description | Template Id | Channel | Variant | Available
~ @ First story & 100%
-+ lower line 10041 [PROGRAM] %  [Default] ¥ o 100%
+ @ Second story @ 100%
% testbanner 10169 [PROGRAM] [Default] @ 100%
mos: @ Active HosT: 10.11.12.13 START: 5/15/2024 2:00:00 oursmon: 00:30:00 UPDATED: 2:55:02 PM
|Search Q| Y <nofiter> ¢4 = | () Playlist Active VDCP OFF

6. Add a new story and see that Viz Pilot receives the update.

A\ Note: Allitems in a running order need a MOS Object, created in the NCS client, to be visible in the Viz Pilot
playlist.

This concludes the installation test for Viz Pilot. For more information on how to use Viz Pilot with newsroom
systems and Gateway, see the Viz Pilot documentation.
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8.2 VizTrio

Profile: Exarnple Profile G 1 Configuration saved,

B Channel 1
Before running an installation test, check that all settings and see that the connection status in the content control
application is good.

. Connection to the Gateway is good.

. . Connection to the database is good.

. Connection to the Viz Engine renderer is good (program or preview).
. m Connection to the Video output is good (program or preview)

8.2.1 Request Running Order

To request a running order

1. Click File and then select Open External Playlists...
2. If all settings are correct the running orders from configured NCS servers should be visible in the Playlists
tab.

I% Show Directories
Playlists

Status M

INEYYS
Faa

foo |nactive

bar Inactive

Imactive

Cancel

3. Select the playlist and click OK. The MOS playlist for the running order should open.
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Description

v [ First story

= lower line [PROGRAM] [Default]

4. Verify that MOS status in the lower left is Active and has a green checkmark, indicating the playlist is MOS
active. If not and status is indicated in red as Inactive, right-click on the icon and select Request.

Description
v [ First story
= lower line [PROGRAM)] [Default]

v [l Second story

[ testbanner [PROGRAM] [Default]

UPDATED: 3:37:58 PM

5. Add a new story and see that Viz Trio receives the update.

Note: To be visible in the Viz Trio playlist, the corresponding item in a running order requires a MOS object
created in the NCS client.

This concludes the installation test for Viz Trio.

For more information on how to use Viz Trio with newsroom systems and Gateway, see the Viz Trio Documentation.
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9 Troubleshooting

This section explains some common challenges users have when configuring and running the Gateway server with
connections to newsroom systems, Viz Pilot databases and content control applications like Viz Pilot and Viz Trio.

9.1 Common Sources Of Error

« NCS, MOS IDs, and MSE IDs are case-sensitive (check the newsroom system and Gateway).

« Gateway must be restarted after configuration changes.

+ Software or hardware firewalls are blocking connections. Verify that the gateway has connections to all
newsroom systems and control stations.

9.2 TipsAnd Tricks

Here are some useful fixes and workarounds.

+ Running Orders from the Newsroom System Are Not Visible in Viz Pilot or Viz Trio

+ Auto Activation (Routing) Enabled for Running Orders, but Are Not Automatically Enabled or Forwarded to
the Control Station

+ Data Elements (MOS Objects) Are Not Showing up in the Newsroom System

+ Gateway Server Is Not Running (Running Status Is Red)

« Ports and Connections Are Irregularly Opened and Closed

+ Advanced Queuing (AQ) Is Not Working Properly

« Changes Are Not Taking Effect

9.2.1 Running Orders from the Newsroom System Are Not Visible in Viz Pilot or Viz
Trio

+ Check the configuration on the newsroom system. Is the Gateway configured with the correct IP or
websocket URL, as well as MOS/NCS-id? Remember that these IDs are case-sensitive.

+ Check the logs on the newsroom system. Is the system sending anything to the Gateway when a new running
order is created? If not, make sure that no firewall (software or hardware) is blocking the connections, and
that the configurations are correct.

+ Inthe Gateway Controller Client, check that there are at least two connections to the newsroom system. If
no connections are shown, verify that the IP address entered for the system is correct, and that no firewall
(software or hardware) is blocking the connections. Check the log window for errors and warnings.

« In the Gateway Controller client, check that there is exactly one connection to each control station (media
sequencer) that you wish to use.

» Enable logging of traffic, and set the log level to “notice” in the controller client:

+ Is the gateway receiving any traffic from the newsroom system? If not, the source of the problem is
likely to be the communication between the newsroom system and the gateway.

« If the gateway is receiving traffic (like a “roCreate” when creating a rundown and MOS activating it), is
the gateway sending any traffic to the control stations after receiving such a message?
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« If messages are sent to the correct IP (control station), check the media sequencer logs on this
computer for errors.

9.2.2 Auto Activation (Routing) Enabled for Running Orders, but Are Not

Automatically Enabled or Forwarded to the Control Station

If routing is used, either based on roChannel or “default routing”, make sure that every newsroom system the
control stations should receive running orders from, check the enable autoactivation checkbox in Advanced
Settings.

9.2.3 Data Elements (MOS Objects) Are Not Showing up in the Newsroom System

The Gateway pushes a list of MOS objects to each connected newsroom system, only if the checkbox
pushmoslist is checked.
The Gateway sends MOS object messages each time a Viz Pilot data element is created, modified or deleted,
only if the checkbox send mosObj is checked.
The Viz Pilot Database section of the Gateway must be enabled in order to send MOS objects, and the “DB
connected” indicator must be green. If the indicator is red, and the “enable Viz Pilot Database” is checked,
check for errors and warnings in the log window.
Some common errors:
« Isan Oracle client installed on the computer running Gateway with a version matching the
configured database?
« Isit possible to log onto the Oracle server using the same credentials as entered in Gateway
Controller Client, using the SQL Plus interface?
Check Gateway’s log messages to see if MOS messages are sent to the newsroom system.
Database schema names are case sensitive. The default Viz Pilot database schema name is PILOT (all upper
case). Check the database installation to see if this is correct, or if another schema name is used.
Check that the database is running by logging onto the database using SQL Plus.
Check that the Oracle client’s environment path is correctly set. Run the Media Sequencer in console mode
and check the console’s output for problems related to the Oracle Call Interface (OCI) library.
See also Advanced Queuing (AQ) is not working properly.

9.2.4 Gateway Server Is Not Running (Running Status Is Red)

Check for error and warning messages in the log window.
Gateway fails to start if another Gateway is running on the same computer, for example an old Gateway
version 1.x.

Note: A Gateway server must not be used by control stations as a regular Media Sequencer. If so, the Media
Sequencer will not run as a Gateway server. If this has been done, re-activate the Media Sequencer to run
as a Gateway by clicking the Start button.

Copyright © 2024 Vizrt Page 79



Gateway Administrator Guide - 5.7

9.2.5 Ports and Connections Are Irregularly Opened and Closed

« Check firewall settings for ports that need to be open.
+ Check typical router and routing issues.

9.2.6 Advanced Queuing (AQ) Is Not Working Properly

« An XML parser failure may be an indicator that the wrong AQ protocol is in use on the database.
« Checkif the Extended AQ is in use on the database. Gateway should detect if AQ is in use or not and set the
correct parameters.

9.2.7 Changes Are Not Taking Effect

Most changes on the Gateway server require a restart of the server. Use the Gateway Controller Client to check the
settings again, and restart the Gateway server by clicking the Restart button.
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10 Glossary

This section explains some of the expressions and acronyms used in this manual.

Expression

Media Object
Server

MOS Lower Port

MOS Upper Port

Running Order

Viz Content Pilot

Accumulate
Running Order
List

Ac
ro
ny
m

o=

Description

MOS is an evolving protocol for communications between Newsroom
Computer Systems (NCS) and Media Object Servers (MOS) such as Video
Servers, Audio Servers, Still Stores, and Character Generators.

For more information, please see the MOS Protocol website: http://
www.mosprotocol.com.

MOS Lower Port ( 10540 ) is defined as the default TCP/IP port on which

the NCS accepts connections from MOS devices. Multiple simultaneous
connections are supported. This socket is referred to as Media Object
Metadata port in the Message Types section.

MOS Upper Port ( 10541 ) is defined as the default TCP/IP port on which

the MOS accepts connections from the NCS. Multiple simultaneous
connections are supported. This socket is referred to as Running Order
port in the Message Types section.

To Viz Pilot and Viz Trio, a running order is the same as a playlist. It
contains objects that reference the information about graphics
elements created by the journalist using the Newsroom Connect
Component.

A Running Order consists of zero or multiple stories, which again
contains one or multiple items.

Objects can appear multiple times in a story, but only once in an item.

This product is now re-named Viz Pilot, but you can still find references
to its old name.

When this setting is enabled, Gateway keeps an internal list of available
rundowns. Less traffic is generated to and from the NCS when the list is
accumulated internally.
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11 Initializing Gateway Server And Clients

This section describes starting the Gateway Controller Client, explaining the necessary Media Sequencer
configuration.

« Starting the Gateway Controller Client.
«+ Configuring Media Sequencer as a Gateway Server

11.1 Gateway Controller Client

You use the Gateway Controller Client application to enable Media Sequencer gateway functionality.

11.1.1 Starting the Gateway Controller Client.

To Start the Gateway Controller Client

0 Important! This operation starts the Gateway Controller as a web-application in the user's default web
browser. The Media Sequencer must be running before starting this Gateway Controller.

1. Launch the Gateway Controller by either
a. From the Windows Start menu, select All Programs > Vizrt > Gateway Controller web interface.
or
b. Browse to the web address: http://<ADDRESS>:8580/app/gatewaycontroller/gatewaycontroller.html.
(Substitute <ADDRESS> above with the actual IP or hostname of the Gateway server).
2. (Optional) Itis possible to use one instance of the client to connect to multiple Gateway servers.
Connect to one server at a time, providing the appropriate connection parameters.

The Gateway Controller Client application enables Media Sequencer (MSE) to run as a gateway server, providing
functionality like start, stop and restart of the MSE Gateway.

Log Traffic ¥ Errorsioi Warninzs 0 ges(95] S Yerbose (Ol

Type Time Source
info 20 Wiz Gatewy atewy 3y,

- info WizGateway VizGateway Initialized

-7 info

@ Start

11.2 Media Sequencer (MSE)

A\ Note: The Gateway Controller client enables the Media Sequencer to run as a Gateway server.
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« While running as a MOS Gateway, the Media Sequencer runs exclusively as a Gateway and should
not be used for any other purpose.

« Itisrecommended to enable the Automatic launch at system restart option of the Media Sequencer.
This ensures the Media Sequencer is kept running.

11.2.1 Configuring Media Sequencer as a Gateway Server

e

e, ) Media Sequencer Launcher

License container: 0-0 (Any Network license)

0/50 2024-03-0
0/50 2024-03-0

e}

Refresh licenses  4f Settings

Launch as Windows Service Launch in Consale

Launch on system startup

Mot Running

To Start the Media Sequencer as a Gateway Server

e
1. Select and run Media Sequencer in the Vizrt program menu, or double-click its desktop shortcut icon:

A\ Note: Itis not possible to configure settings using the non-admin Media Sequencer launcher. Configuring
the Media Sequencer licenses requires administrative rights.

2. As of version 5.4 WIBU licenses are required to start Media Sequencer and Viz Gateway.
a. From the launcher, open the Settings window.

b. Select the required license container, ensuring that a MSE_VIZGATEWAY license is enabled. For more
information about configuring WIBU licenses and license alerts, refer to the Media Sequencer
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installed WIBU Licensing documentation at Start menu > All Programs > Vizrt > Media Sequencer

WIBU Licensing Documentation.
3. Click the appropriate button to select how Media Sequencer will start up:
a. Launch as Windows Service: Media Sequencer will run as a service. This enables manual operation

of Media Sequencer as a service.
b. Launch in Console: The service is disabled, and the Media Sequencer only runs as long as the
console is open. If the console is closed, the Media Sequencer stops. This mode is normally only used

for testing or debugging.
4. If Media Sequencer is to start automatically when the system is (re-)started, select Launch on system startup.

Note: It is recommended to run the Media Sequencer as an automatic service (Launch on system startup
selected).
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